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1941 Global Command Decision Manual
by Black Elk (graphics/testing)  &  TheDog, (code/testing)

Introduction
It is late 1941, Germany's invasion of USSR is well under way.  Japan is about to strike in the East.

MAP FEATURES
AI FRIENDLY

 Intended for Solo play vs Fast AI opponents, can use Hard AI for more consider play, but turns will take longer
 81 territories are marked as important to players to guide the AI for better play
 no Objectives, or Politics/Technology phases, both are scripted.

STACKING
 Stacking limit is enforced to help the AI and player so they don’t over stack.
 Only 10 Air & 10 Sea units are allowed per Sea Zone/Territory, except 2 Hit Battleship, Carrier & Carrier-Fleet 5 units per 

Sea Zone
 Only 20 Land Units per territory, except 2 Hit Armor-Inf & Armor-Hvy 10 units per territory
 Only 1 (Industry-Hvy, Industry-Med, Industry-Lgt, Base-Camp) is allowed per territory 
 Allied stacks are typically ½ the limits above, eg 5 Allied Air & Sea units.  Except Convoy units where 10 allied Convoy are 

allowed

GAME PLAY
• Turn sequence; PU Resources (from previous turn), Combat Moves, Non-Combat Moves, Repairs, Purchases then 

Placements.
• Battle Rounds: Land Battles last up to 7 rounds, Sea Battles 5 rounds, Air Battles 3 rounds; these can be changed in map 

options.  This feature encourages you to over commit to ensure a victory in a turn.  Having limited Battle Rounds can result 
in battles being a draw, shown by a colored hatched pattern.  Land AA fire is only for 2 rounds.  Sea AA fire is only for 2 
rounds. The territory/Sea Zone PU is not collected until it is resolved.
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• PU resources are collected from territories at the start of the round.  This means that losses and gains in territories PU is 
not taken into account until the start of the next round, so after all other players have had their turn.

RAILWAYS
 Each Industry has invisible rail links that allow land units to move a total of 3 territories per turn.

TECHNOLOGY
 Is pre-planned and it will occur from a certain round with a small random chance, so cannot be relied on, see each nations 

starting panel.
 Map rounds are loosely 3 months, so 4 to a year, this is for the benefit of the scripted Technology advances, but don’t 

treat this as a hard fact.

UNITS – HQ Commands
Four types of HQ Commands, Air, Army, Fleet and Submarine, nations can have between 0-5 types 
of a HQ.  These represent Manstein, Montgomery, Patton, Cunningham, Donitz, Nimitz, US 8th Air 
Force HQs etc. and their staff and equipment.

ANTI AIR (AA)
• There is no AA ground unit, instead each unit has its own built in AA defense.
• Typically moving ground units have an AA defense of 1 in 6, more units equals more AA defense.
• Ships have higher AA defense between 1 for Destroyers to 3 for Battleships.

UNIT STATS
• Unit Stats are not your typical WWII stat block, so play with an open mind.
• Eg. Fighter      has 1 Atk, 1 Def verses ground units and 3 Atk, 3 Def verses aircraft
• Eg. Bomber    has 1 Atk, 1 Def verses ground units, no attack v ships, best used to Strategic Bombing Raid (SBR) industries
• Eg. Destroyer has 1 Atk, 1 Def, 3 Move and costs 5pu.
• Eg. Cruiser      has 2 Atk, 2 Def, 3 Move and costs 8pu.
• Eg. Convoy     has 0 Atk, 1 Def verses Submarines, so is Anti-Submarine as it includes Corvettes & Frigates



1941 Global Command Decision Manual v235   Pages 3 of 15

SEA ZONES GENERATE PU
• Sea Zones generate 1-2pu per round, these values are not shown on the map, only in the status bar. This means the Battle 

of the Atlantic is free range & roaming, while Britain and the US should hunt down the U-boats.
• Typically the Sea Zone adjacent to a “canal” like Panama Canal, Danish Straits, Gibraltar Straits,  Suez Canal are 2pu. 

However Bosporus Straits and Dardanelles Strait Sea Zones are only 1pu. (As it was closed to most nations)

BLOCKADE
 Each enemy coastal territory can be Blockaded up to the value of the Territory PU
 Each Destroyer, Cruiser, Battleship causes Blockade of 1, meaning loss of -1pu to the enemy territory
 Each Submarine, any type                 causes Blockade of 2, meaning loss of -2pu to the enemy territory

POLITICS
Is scripted, Brazil, Gulf States and Mexico will always join the USA on certain rounds.

USSR has special border controls (*1 see following page)
The allies cannot enter USSR territory, as Stalin refused allied units on USSR soil.  However as the allies can retake USSR 

territory and give it back to the USSR, it is possible to have allied units unable to move or be reinforced if surrounded by USSR 
territories, so be aware of advancing too far into USSR territory.  Best to stay on the edge, like at Baku and not advancing deeper.

Japan & USSR Non-Aggression Pact
 Rounds 1-10+ The USSR and Japan have a Non-Aggression Pact that prevents both sides from attacking each other.
 Round 11+ there will be skirmishes on their borders.
 Round 12+ there is a 1 in 3 chance the NAP will be broken and war will be declared.

Of Note
• Be aware that Allied relationship has givesBackOriginalTerritories, this means that if you hold or take an allied Original Ter-

ritories it goes to that ally, not to the faction that took/holds it.
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POLITICAL RELATIONSHIPS
By pressing Ctrl+W shows the Political Relations panel
Political 
Relations label

Short phrase Used by

War At War All player nations

Allied Allied with AXIS
Allied with Allies

Germany, Italy, Japan are allied
Britain, China, Pacific-Allies, USA (not USSR)

Allied-USSR Allied with USSR Britain, China, Pacific-Allies, USA are Allied with USSR, but cannot enter USSR territory (see *1 
on previous page)

Open-Border Open to Axis & USSR Germany, Italy, Japan & USSR can invade Neutrals (including Aircraft)

Closed-Border Closed to Allies
Japan-USSR Closed

Britain, China, Pacific-Allies, USA
Japan & USSR None Aggression Pact (NAP) 1-11 rounds, then 1/3 chance to change to War

AI ONLY
Open-Border
Closed-Border

Open to AI Axis & USSR
Closed to AI Axis & USSR

AI Germany, Italy, Japan & USSR (1/3 chance each) can invade Neutrals (including Aircraft)
AI Germany, Italy, Japan & USSR (2/3 chance each) cannot invade Neutrals

Below AI Italy can invade Neutrals, AI Germany, Japan & USSR will not.
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GAME PLAY
It is a large map, with almost 800 (796) land & sea locations and is intended for;
 solo play with the remaining nation’s using Fast AI or Hard AI.  It is AI friendly, no Objectives and Politics/Technology are 

scripted
 2 sided play, eg. 3 Axis nations verses 5 Allied nations
 Can Use/not use or AI=Do Nothing, all factions, to learn to play for faster game play.

Protagonist Includes Alliance Notes

Germany Finland & Balkans, French overseas Axis Hard to play as fighting on two opposed fronts west & east

USSR Allies A reactionary force, war on west front, later to the south

Italy Romania, North Africa Axis Easy to play, war to the east and south

Britain Canada, Egypt, India, South Africa Allies Hard to play, front to west, east, Med, Middle East & India

Japan Hisaichi, Thailand Axis Hardest to play, front to west, south & east and later to the north

USA Brazil, Gulf Rim, Mexico, Panama Allies King maker nation, where ever it goes, it should win

   Pacific Allies ANZAC, Dutch East Indies, French Allies Easy to play, could be played with China and/or USA

   China Allies Easy to play, could be played with Pacific-Allies and/or USA
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GUIDE TO NON-MOVING UNITS

• Industries generate 5-9pu per turn
• Industries have invisible “rail links” and can move land units up to 3 territories, depending on terrain effects.  Sometimes 

this produces inconsistencies in move 2 units like armor over mountains, where they cannot move 3, work around it.
• Factories, each Factory generate 3pu per turn

Units Generate
PU / turn

Territory Max Unit 
Production

/ turn

Notes

Base-Camp 0 Not in an industry territory
Place in a 1+pu territory

1 Produce: Inf-Conscript, Inf-Trained, Inf-Elite, Inf-
Motorized

Industry-Lgt 5 Only 1 industry allowed
Place in a 5+pu territory

2 Produce: As above & Armor-Lgt, Artillery, Bunker,   
HQ Army

Industry-Med 7 Only 1 industry allowed
Place in a 7+pu territory

3 Produce: As above & all Fighters, Bomber-Tac,  
Armor-Med, Anti-Tank, Destroyer, Convoy

Industry-Hvy 9 Only 1 industry allowed
Place in a 9+pu territory

4 Produce: As above & Air-Transport, Bomber, All-
Rockets, Armor-Hvy, Cruiser, Battleship, Carrier, All 
Submarines, all HQ

Factory 3 Up to 2 / Territory. 
Place with any Industry-
Med or Industry-Hvy

- Simulates increased production, if the war effort can 
afford the investment.  ROI after 3 rounds.

Lend-Lease-
Depot

1 Vary 8-20 in a territory, 
generating 8-20pu/turn

Vital to USSR as they have 3 & China has 1.

Oil-Field 1 Vary 1-20 in a territory, 
generating 1-20pu/turn

Cannot be destroyed
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PU GAIN & LOSS

PU Gain per turn
 Each Land Territory generate 0-9pu
 Each Industry-Lgt, Industry-Med, Industry-Hvy respectfully generate 5, 7 or 9pu
 Each Factory 3pu
 The 4 Lend-Lease-Depot generate 8-20pu
 Oil-Fields generate 1-20pu
 Each Sea Zone generates 1-2pu per turn, the owner of the PU has a national flag in the Sea Zone

PU Loss per turn
 Each unit (except Base-Camp, Lend-Lease-Depot, Industries, Factory) consumes an Upkeep/Maintenance -1pu
 Each 2HP unit (Armor-Inf, Armor-Hvy, Battleship, both Carriers, not Bunker) consumes an Upkeep/Maintenance -2pu
 All land territories bordering Sea Zones can be blockaded.  There are no convoy centers/route/zones.

o Each Blockading enemy ship (Destroyer, Cruiser, Battleship) reduces PU by -1pu
o Each Blockading enemy Submarine (HQ-Submarine, Submarine, Submarine-Adv) reduces PU by -2pu
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MOVEMENT
The 3 Industries Hvy, Med, Lgt have a built in Rail Links that allow land units that move 1 and move 2 to move 3 territories if 
starting in an Industry territory.  This is important for moving units across Europe, Asia and the USA.

Terrain Effects
Below is a list of the terrain effects;

Happens every 4 turns, starting turn 2, only Inf-Elite, Armor & Air can attack

Seaborne Landing/Assaults
Are difficult to simulate and this is our version.

• Inf-Elite being Marines gain +1 Atk, so attack on a 2
• Atk 1 units are not modified, so attack on a 1
• Atk 2+ units suffer -1 Atk, eg Artillery attack on a 1 and Armor-Med attack on a 2

Of Note
 Infantry & Anti-Tank are ideal for holding/defending terrain
 Air units in Desert & Tundra gain +1 Atk (The open terrain is difficult to hide from aircraft)
 Units with Atk 2+ suffer -1 Atk in Forest, Mountains & Urban, eg. Armor-Med 3 Atk -1 = 2 Atk
 Move 2 units going into Mountains & Tundra are reduced to Move 1

Canals & Straits
Canal Territory control to pass through Strait Territory control to pass through

Panama Canal Panama  96 ↔ 89D SZ Straits of Gibraltar Gibraltar 91A ↔ 92 SZ

Suez Canal Cairo-Egypt & Sinai 98 ↔ 81 SZ Danish Straits Copenhagen-Denmark 113A ↔ 113B SZ

Bosphorus Straits Istanbul & Ankara 100A ↔ 129 SZ

Dardanelles Straits Istanbul & Smyrna 99A ↔ 129 SZ
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AIR UNITS
 The usual Attack and defense values are only used to fight Land & Sea units
 The Air Attack and Air defense values are only used to fight Air units in Dog-Fights
 Stack in 10s, except HQ-Air Stack in 1s (as there is only a max of one per nation)

Air Units Surface
Atk

Surface
Def

Move Air
Atk

Air
Def

Scramble
Intercept

Escort

Notes

HQ-Air 1 1 8 3 3 Yes Max 1 (only Britain, Germany, Italy, Japan, Pacific-Allies, USA)
Fighter-Early 1 1 3 2 2 Yes Scramble 1, Air Superiority, Combat Air Patrol
Fighter 1 1 4 3 3 Yes Scramble 1, Air Superiority, Combat Air Patrol
Bomber-Tac 2 1 4 1 1 Dive Bomber/Ground Attack/Torpedo Bomber

good v Bunkers & Base-Camp & Ships
Can also do Strategic Bombing d2-1 v Industries

Bomber 1 1 6 1 1 Strategic Bombing d3-1 v Industries
Air-Transport 4 Carry up to 8 TCs worth (eg. 4 Inf-Elite or 2 Inf-Trained)

Kamikaze-Plane 3 3 3 Scramble 1, Suicide v ships (only Japan)
Fighter-LongR 1 1 6 3 3 Yes P51-Mustang (only Britain & USA) 
Fighter-Jet 1 1 4 3 4 Yes Scramble 2 (only Britain, Germany, USA)

Bomber-LongR 1 1 8 1 1 Strategic Bombing d3-1 v Industries (only Britain & USA)
Nuclear-Bomber 6 1 8 1 1 Also has 10 attacks & will auto kill up to 10 units

or Strategic Bombing 10+d3 auto killing an Industry (only USA)

V1-Rocket 1 2 Strategic Bombing d2-1 v Industries (only Germany)
V2-Rocket 1 3 Strategic Bombing d2 v Industries (only Germany)
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LAND UNITS
 The usual Attack and defense values are only used to fight land battles
 The Anti-Air defense value is only used to fight Aircraft, this only for 1st & 2nd rounds
 Transport Cost (TC) of Inf-Elite (Marines, Paratroopers) is only 2 and Inf-Trained & Inf-Conscript is 3
 Units with Atk 2+ suffer -1Atk for Amphibious attacks, eg. tanks & Artillery. 
 Inf-Elite gain +1Atk for Amphibious attacks.
 2 Hit units like Armor-Inf & Armor-Hvy can only stack in 10s.

Land Units Atk Def Move Anti 
Air 
Def

Trans
port
Cost

Stack Notes

HQ-Army 4 4 2 1 4 5 Max 5.  Blitz, can transport 1 Anti-Tank, Artillery or Infantry unit
-1Atk Amphibious

Inf-Conscript 1 1 1 3 20 China, USSR and when some nations home ground is invaded
Inf-Trained 1 2 1 1 3 20 Most European nations & allies, Japan, China & USSR Guard
Inf-Elite 1 2 1 1 2 20 +1Atk Amphibious.  Includes Marines, Mountain, Paratroopers, Ski, Special 

Forces & Veterans
Inf-Motorized 1 2 2 1 4 20 Blitz, in trucks & half tracks

Armor-Lgt 2 2 2 1 4 20 Blitz, can transport 1 Anti-Tank, Artillery or Infantry unit, Includes armored 
cars.  -1Atk Amphibious

Armor-Med 3 3 2 1 4 20 Blitz, can transport 1 Anti-Tank, Artillery or Infantry unit
-1Atk Amphibious

Armor-Hvy 4 4 2 1 4 10 Blitz, can transport 1 Anti-Tank, Artillery or Infantry unit, 2 Hit Points
-1Atk Amphibious

Armor-Inf 3 3 1 1 4 10 2 Hit Points
-1Atk Amphibious (only Britain/Churchill & USSR/KV-1)

Artillery 2 2 1 1 4 20 First Strike, support to one Inf unit +1Atk, & Suppresses enemy 
Bunker -1Def.  -1Atk Amphibious

Anti-Tank 1 2 1 1 4 20 First Strike, & Suppresses enemy Armor/Inf-Motorized -1Atk.
Bunker 2 2 2 Hit Points, only 2 allowed per territory
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SEA UNITS
 The usual Attack and defense values are only used to fight surface ships
 The Anti-Air value is only used to fight Aircraft, this only for 1st & 2nd rounds
 HQ-Fleet, Destroyers, Cruiser & Carrier-Fleet Move 3
 All submarines (HQ-Submarine, Submarine, Submarine-Adv) cause Blockade of -2 (hidden terrors)
 2 hit units like Battleships & Carriers can only stack in 5s

Sea Units Surface
Atk

Surface
Def

Move Anti-
Air

Block
ade

Stack Notes

HQ-Fleet 3 3 3 2 -1 3 Bombard 2, Transport Inf-Elite, Max=3 (Britain, Italy, Japan, 
Pacific-Allies, USA)

HQ-Submarine 3 3 2 - -2 5 First Strike, Evade, Anti-Surface, Max=5 (only Germany)

Destroyer 1 1 3 1 -1 10 Anti-Submarine
Cruiser 2 2 3 2 -1 10 Bombard 2, Transport Inf-Elite
Battleship 4 4 2 4 -1 5 First Strike, Bombard 4, Transport Inf-Elite or Inf-Trained

2 Hit Points

Convoy 1 2 1 10 Carry up to 14 TCs worth (eg. 7 Inf-Elite or 4 Inf-Trained)
Anti-Submarine as it includes Corvettes & Frigates

Submarine 2 2 2 - -2 10 First Strike, Evade, Anti-Surface
Submarine-Adv 3 2 2 - -2 10 First Strike, Evade, Anti-Surface

Carrier 1 2 2 5 Carry 2 aircraft, Fighters/Bomber-Tac, 2 Hit Points
Carrier-Fleet 1 3 2 5 Carry 3 aircraft, Fighters/Bomber-Tac, 2 Hit Points
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UNIT SUPPORTS

Unit Giving 
support 

Receiving Allied Unit  gains +1 Atk & +1 Def Applies to these 
nations

HQ-Air Dog Fight: 5 Allied Bomber, Bomber-Tac, Fighter, Fighter-Early, Fighter-Jet, Fighter-LongR
Land/Sea: 5 Allied Bomber, Bomber-Tac, Fighter, Fighter-Early, Fighter-Jet, Fighter-LongR

Britain, Germany, 
Italy, Japan, Pacific-
Allies, USA

HQ-Army Dog Fight:  5 Allied Bomber, Bomber-Tac, Fighter, Fighter-Early, Fighter-Jet, Fighter-LongR
Land: 5 Allied Anti-Tank, Armor-Hvy, Armor-Inf, Armor-Lgt, Armor-Med, Artillery, Inf-
Conscript, Inf-Elite, Inf-Motorized, Inf-Trained

All

HQ-Fleet Dog Fight:  5 Allied Bomber, Bomber-Tac, Fighter, Fighter-Early, Fighter-Jet, Fighter-LongR
Sea: 5 Allied Battleship, Cruiser, Destroyer, Submarine, Submarine-Adv

Britain, Italy, Japan, 
Pacific-Allies, USA

HQ-Submarine Sea: 5 Allied Battleship, Cruiser, Destroyer, Submarine, Submarine-Adv Germany

Unit Giving 
support

Receiving Allied Unit  gains +1 Atk Applies to these 
nations

Fighters Bomber-Tac (Combined-Arms) Britain, Germany, 
Italy, USA

Armor Bomber-Tac (Combined-Arms) or
Inf-Motorized (Combined-Arms) 

Britain, Germany, 
Italy, USA

Bomber-Tac Inf-Trained, Inf-Elite, Inf-Motorized, Anti-Tank, not Inf-Conscript (Combined-Arms) Britain, Germany, 
Italy, USA

Artillery Inf-Trained, Inf-Elite, Inf-Motorized, Anti-Tank, not Inf-Conscript All

Unit 
Suppressing

Enemy Unit Suppressed, suffer Applies to these 
nations

Artillery Base-Camp, Bunker (suffer  -1 Def) All
Bomber-Tac Base-Camp, Bunker (suffer  -1 Def) All
Anti-Tank All-Armor, Inf-Motorized (suffer  -1 Atk) All
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As can be seen not all Nations can give and receive the same supports.
• HQs are vital to winning the war and are your most important asset.
• Britain, Germany, Italy, USA can use Combined-Arms, the synergy of combined arms, Fighters, Tactical Bombers, Armor 

and Infantry. Germany being mainly land based benefits the most.
• To counter enemy Armor try to face it off with Anti-Tank to reduce/blunt its attack.
• Bunkers play a vital role in this game and to increase your chances of success bring Artillery and Bomber-Tac to suppress 

them.

HOW TO MAXIMIZE YOUR CHANCES OF WINNING A TERRITORY WITH 2 ENEMY BUNKERS

• Attack with 1-2 Artillery per Bunker to suppress it and at least 4 Inf-Trained or Inf-Elite to get +1 Artillery Support
• Attack with 1-2 Bomber-Tac per Bunker to suppress it
• If you have Inf-Conscript use them in the Attack to lead the attack so they are casualties, before your Inf-Trained
• If the Territory has Terrain Effects, like a Mountain, try to attack with a HQ-Army to mitigate the bad effects
• If the Territory, is coastal use many Inf-Elite (Marines get +1 Attack if sea borne) with Bombard support from Battleships & 

Cruisers
• Land Battles end after 7 rounds of combat, this is deliberate to encourage over committing units to ensure a win
• If a Combined-Arms nation (Germany, Italy, Britain & USA) try to pair as many units, on a 1 for 1 basis, as possible to 

maximize their support bonus synergy

• Check the status bar terrain type you are attacking and the note the terrain effects
• Check the Tool Tips for each unit, especially the lines with asterisks (*) as they may guide you
• Check this manual, it has words/stats of wisdom
• As a guide the game tries to use military histories 3 to 1 rule to win. (Remember this a TripleA game and not A&A game)
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WIN CONDITIONS
Yellow stars on the map show that a territory is a Victory Center

Occupy 21 Territories of the following 29 territories

Below is a list of Victory Center territories grouped by region and held at game start
where 11 Red=Axis  &  18 Blue=Allies     o=Oil-Field, for extra pu

WEST MIDDLE EAST AMERICAS
Bengazi-Cyrenaica (o) Baghdad (o) Balikpapan-S.Borneo (o) Honolulu-Pearl Harbor
Berlin-Cen.Germany Baku- Azerbaijan (o) Bangkok-Siam Panama
Cairo-Egypt/Suez Canal (o) Calcutta Hong Kong-Kwangtung San Francisco-Cen.California
London-S.England Helsinki Manila-Luzon (o) Washington D.C.
Paris-Cen.France Leningrad Medan-W.Sumatra (o)
Ploiesti-E.Romania (o) Moscow-Cen.Russia Shanghai-Kiangsu
Rome-Cen.Italy Stalingrad-Volga Sydney Canberra-New South Wales
Warsaw-Cen.Poland Uzbekistan (o) Truk-Coraline

Tokyo

Economically the following are important as they provide extra PU to USSR and China.
Four Lend-Lease-Depots;

• 3 in USSR: Archangelsk, Persian Corridor to Baku, Vladivostok and 
• 1 in China: Burma Road to Yunnan China
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GAME OPTIONS before pressing Play button
• Use Events: Winter Weather – to turned it on in Game Options> Use Events: Winter Weather (tick), bottom right

GAME OPTIONS in game
• To reduced failure notices Game> User Notification> Show Trigger/condition Chance Roll Failure (UnTick)
• For those players who don’t like the maps colors, for a slight alternative in game. View> Show Map Blends (Tick)
• For those players that miss the roundels, to display mini national flags.  View> Flag Display> Small

ENGINE PREFERENCES
These will effect all your maps;

AI Tab (for faster game play)
AI Move Pause Duration set to 0
AI Combat StepPause Duration, set to 0
Click Save (Button)

UI Theme (for a lighter User Interface)
Set to Substance Mist Silver or similar
Click Save (Button)
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